
 
 

 

 

PackMan 

 

Privacy is a growing concern for anyone educated about digital information.  When mail 

was accomplished with paper and a Post Office there was no network admin that could 

read it, there was no ISP (Internet Service Provider) that could read it, and no one could 

generate a copy of the information as it traveled over wireless networks.  Many Financial, 

Legal, and Health Care providers safeguard information between the business and the 

customer through private account logins with secure websites but cannot deliver new 

information or account status information due to the security problems of common email. 

 

Many companies have “Privacy Agreements” that they fail to uphold because they do not 

properly protect information at every stage of communication.   When email is used to 

transfer customer information between members of the same business it potentially may 

violate the “Privacy Agreement”.  Also business documents such as Invoices and 

Purchase Orders are important to protect from people that have no business intercepting 

them. 

 

Privacy of email is a growing concern, but equally as important is to guarantee the 

authenticity of email.  Many people are aware that email was designed to be anonymous.  

Like a letter from the post office, the return address may not be the actual address of the 

sender. Unlike a letter from the post office email does not come with an identifiable ink 

signature, a postmark indicating region of origin, or even company letterhead that might 

help verify the authenticity.  By communicating through PackMan, you can be sure that 

the message you received was sent from the person you expected. 

 

These long seen, obvious, and growing problems with email have enacted countless 

corporate policies that forbid the exchange of information over email between the 

customer and the business when the information is of a sensitive nature or when 

authenticity is critical.  Forcing the slow and more secure postal delivery of documents 

that already exist in digital form, and the use of old technology (and also unsecured) FAX 

delivery because it is less likely to fall into the wrong hands. 



 

These same problems have also prompted the creation of technical email solutions that 

for the most part have only been adopted by technical organizations due to the 

complexity, cost, and management of email systems that use digital signatures issued by 

3
rd

 party CA’a (Certificate Authorities) that use Public Key encryption also known as 

asymmetric cryptography. 

 

Package manager uses a very different and equally secure approach using a symmetric 

key block cipher that has been approved by the U.S. government for the protection of the 

most sensitive information.  This eliminates the need for a CA, or any external business 

to be involved with the message exchange.  This greatly simplifies and expedites the 

setup and adoption of secure email.   

 

Symmetric key ciphers simply require both parties to know the same password that can 

be exchanged in person, by mail, over a secure website, or by phone if the conversation is 

guaranteed to be private.  You might decide to use the password of something that only 

both of you know.  A lawyer could provide it in person at the time of offering this 

communication option to their customers.  A bank could allow you to set the password 

for automatic email delivery of statements when logged into you account on their 

website. 

 

Historically the only weakness to symmetric key security is user error in password 

management.  Packman greatly simplifies this management by storing the passwords in 

an encrypted database.  You should not write them down anywhere else, and there is no 

need to remember the password once you have entered it into your personal contact 

database. 

 

Communication privacy may also need to be defined to groups or departments.  For 

example, the IT department has no business reading documents intended for the financial 

or executive groups.  With Packman, every member of a group may decide to share a 

common password so that one document may be forwarded to multiple recipients and 

only those recipients may read the document. 

 

Email is only one area of concern when considering privacy.  Files stored on USB 

Memory Sticks can often be accessed by anyone who has access to the network of the 

machine it is plugged into.  Private files often need to be placed on public networks so 

that they are included in corporate backups.  Shared machines at home, in libraries, at 

school, or other places also creates a need to be able to easily store private information.  

Laptops and mobile devices often use unsecured public wireless networks, when the data 

is a PackMan package it doesn’t matter if someone is lurking on the public network.  

Package files are not always created to transfer information privately, they are also 

created to store private information that is always accessed by the same person. 



No barriers to using Packman 

 

Packman is very simple to use.  The first step to using Packman is obtaining the software.  

The executable is only 580kb (about half of 1 MB) and requires no supporting runtime 

like Java or .NET.  It is also FREE.  Compare to other somewhat similiar products (like 

Adobe’s PDF viewer at 22.4 MB or Winzip at 9.9 MB).  PackMan also allows you to 

CREATE documents for free – not just view them like PDF.  Packman also opens .ZIP 

files, supports better viewing of them than WinZip, and often even compresses them 

down a little smaller in the PKM format.  It’s not like Winzip that is illegal to use after 

you are done evaluating it.  There is no upgrade fee.  If you purchase Winzip version 11.0 

even the upgrade to 11.1 is NOT free creating a perpetual cost for the user and a barrier 

to adoption.  Packman upgrading is free forever, and it doesn’t beg for donations or waste 

your internet bandwidth by downloading ads that you must see just to use Packman.  

Packman uses no Internet connection, unless you store your contact database remotely, 

then it uses the Internet only for that purpose.  PackMan is true Freeware, certifiably not 

Spyware, and obviously not Adware.  This is a strategic decision by UBT that is based on 

the same principles that have priced Netscape Navigator, FireFox, and Internet Explorer 

for free.  The value for UBT is in custom business integrations that use Packman, not for 

users of Packman.  If your corporation generates 1 Million Packman files per day and 

enables all 100 Million of it’s customers with PackMan, even that is free.  Packman has 

no usage limits.  

 

UBT will sell special Packman integration software that helps to automate supply chain 

business processes and integrate with ERP and Accounting backend systems - that is 

where UBT will get paid for all the investment and hard work that went into building this 

high quality software.  The vast majority will get something for nothing and in allowing 

that, UBT builds the value of the corporate integration tools for PackMan.  Anyone is 

free to use and distribute Packman, but it may not be modified, decompiled, 

disassembled, or reverse engineered.  If you agree to that very simple license then you are 

free use PackMan, which is better than other solutions that are not free. 

 

UBT has positioned Packman to be one of the most popular software tools of the future, 

and plans to shape and drive the future with quality software development and intelligent 

licensing that will not hinder adoption anywhere.  Distributors such as Dell, HP, 

Gateway, IBM, and Sony are free to include Packman with OEM distributions that are 

then more useful for their customers. 

 

 

The solution 

 

United Business Technologies developed a portable file system that is designed to render 

documents and store files.  This is a unique product in a category that has many 

competing software solutions.  There are countless encryption utilities available but none 

of them have integrated the advanced document rendering capabilities that PackMan 

supports.  Some encryption tools do have direct support for email like Packman does but 

none of them have support for threaded conversations and attachment versioning like 



PackMan.  PackMan also provides built in tools for password management and for 

scripting common tasks. 

 

 

Attached Files 

 

Each Package may contain any number of files inside it.  In this respect it may be 

comparable to popular compression software like Winzip.  However Packman supports 

versioning of the same file, Winzip does not.  Packman can quickly verify integrity using 

a stored SHA-2 digest, Winzip does not.  PackMan supports user added comments for 

each file it contains, Winzip does not.  Packman supports better encryption, and more 

robust attachment management through the Graphical User Interface than Winzip by 

allowing a hierarchy explorer like view, or the standard sortable list view, or both.  Like 

Winzip the package is also compressed, and done so more efficiently in many cases. 

 

 

Document Rendering 

 

Each package supports complex document rendering.  It is based on a technology called 

RTF (Rich Text Formatting) which is better suited than HTML for professional looking 

documents.  In this respect Packman is comparable to PDF and Microsoft Word.  

However both of those products charge for the software to create the document and only 

give the viewer for free, Packman gives you both for free.  RTF is also very well suited as 

an output format of XSL, so UBT’s XSLT creates native PackMan files from XML. 

 

 

64 bit File System 

The file system used by PackMan is fast and it supports huge files.  It’s almost safe to say 

that there are no limits – but in fact the limits are just very high.  Many utilities have 

limitations set just over 4 GB (2
32 

).  PackMan’s limitations are exponentially higher, 

17,179,869,184 GB (2
64

) which is approximately 10 billion times larger.  The PackMan 

file system uses random access disk reads, so .PKM files may actually serve as simple 

databases that do not require SQL access. 

 

 

Built in utilities  

 

Packman has built in support for automated scripting of attachments.  If you have a large 

complex directory structure and need to exclude or include certain files or folders 

PackMan allows you to define the rule once then it can automatically package only what 

you need saving you the time of manually picking out the required attachments. 

 

Packman also has support for file splitting, so that large packages can be sent through 

email that often has limitations on the attachment size per email.  It can also create 

Packages that span CD’s, DVD’s, or USB storage devices. 

 



Packman also supports opening, viewing, importing and extracting of .ZIP files.  The 

.PKM format is much more feature filled with stronger encryption, storage of a SHA-2 

hash with each attachment to certify integrity, and a better format that compresses tighter 

because .ZIP needlessly stores folders as items in the attachment.  .PKM uses a 

completely different approach. 

 

Packman already supports direct SMTP email delivery as well as integration to Outlook 

and other popular email systems, and is currently adding TLS/SSL as many SMTP 

servers demand it, even though when using Packman it is not necessary due to the fact 

that encryption is already built into Packman. 

 

 

The Contact Manager 

 

The feature that clearly sets PackMan apart from and above other tools that seek to be in 

this class is the Contact Manager.  PackMan has access to a database of passwords.  The 

database is encrypted and stored in a native .PKM format.  The information available to 

PackMan includes names, email addresses, contact information and passwords.  This 

information is used by the graphical user interface to integrate into common mail systems 

and simplify password management.  Each contact database has a master password that 

must be remembered by the user – therefore eliminating the need to remember any of the 

other passwords that are stored in it.  PackMan can automatically prepare emails and 

select the correct recipient for you. 

 

 

Packman security meets and exceeds all industry guidelines 

 

PackMan meets the encryption requirements of HIPAA, GLBA, California SB-1386, and  

Sarbanes-Oxley using industry standard Advanced Encryption Standard (AES). 

 

Packman uses a 128 bit block cipher called TwoFish.  TwoFish is one of the AES 

(Advanced Encryption Standard) finalists and meets the requirements of NIST (National 

Institute of Standards and Technology) for protection of U.S. Government information.  

It is certified for all federal and private use of even the most sensitive information.  It has 

been extensively crypt analyzed, it is fast and efficient.   

 

The cipher is initialized with a 256 bit SHA-2 hash, and each attachment is also hashed to 

verify file integrity even against faulty disk controllers or networking hardware.  SHA 

(Secure Hash Algorithm) was designed by the NSA (National Security Agency) and has 

also been extensively crypt analyzed.  SHA-2 is the strongest variant of the SHA Hash. 

 

 

PackMan Windows Graphical User Interface 

 

UBT has developed a very powerful Graphical User Interface (GUI) for viewing, editing, 

and modifying PackMan files.  To build the most robust interface possible, UBT has 



developed a version of the GUI that runs on Windows only.  Unlike many other Windows 

products, it runs on all versions of Windows – 95/98/ME/NT/2K/XP/03/Vista.  UBT will 

also develop a Unix/Linux version in the future.  UBT has Unix/Linux support for several 

other UBT products and has plans to add Packman to the list but decided to focus on 

Windows first because it has the largest user base. 

 

The GUI supports shell integration and appears as an option when right clicking in any 

explorer window.  It also supports shell integrated drag and drop.  It supports Windows 

Object Linking and Embedding (OLE).  It supports advanced cut and paste operations 

with MS Word.  The GUI uses a standard Single Document Interface (SDI) by default as 

this has been proven to be the least confusing interface design for most users, however it 

also supports a Multiple Document Interface (MDI), which can help a more advanced 

user better manage a situation where many .PKM files are open at once.  The GUI has 

been refined for both ease of use and flexibility for advanced users. 

 

 

Cross Platform 

The PackMan file system can be accessed on Linux and Unix as well as Windows.   The 

document (or message body) uses RTF for several reasons, one of which is that all 

popular Unix word processing systems also support RTF.  UBT has developed the file 

system layer of Packman in a fully portable manner.  When work begins on the 

Unix/Linux GUI, a large portion of the effort is already complete.  For systems 

integrations on Unix/Linux that do not need the GUI, Packman is ready to be put to use. 

 

New to the 2009 version of Packman 

Each package may now contain an array of alternate passwords allowed to decipher the 

package.  This is especially useful if you have one package with 2 or more people 

allowed to open it but each with a unique password.  It also enables the “Master 

Password” feature in the GUI.  When enabled it adds a default entry in the alternate list of 

every package saved. 

 

 

Mobil Phone Integration - Next 

The next version of packman is exploring integrating support for phones.  A Secure SMS 

application with a seamless fit into the User Interface described below.  Xfer, another 

product, has already been tested extensively on various versions of Windows Mobile and 

various makers of hardware platforms to drive it.   

 

 

Getting started Using Packman 

 

Packman has no setup or install program.  Just double click Packman.exe and it’s ready 

to use.  Packman runs anywhere, regardless of user permissions, so it can be used in 

libraries, schools, cyber cafes, and other public computers without any special provisions. 

 



Packman has support for multiple user profiles. If you run it on a public machine, or have 

multiple users on your home computer, you may want to configure more than one user 

profile.  The first time you run Packman, it will ask you for the name of the first profile: 

 

 
 

Enter your name, your family name, or business name.  Press ‘OK’ and you have 

completed the entire setup process.  Next the PackMan application will appear.  Notice 

your profile name circled in red in the following image: 

 

 
 



Creating a Package 

If you want any text or document in your package, you may type it or cut and paste it into 

the main window like this: 

 

 



Adding Attachments 

 

You may select either files or folders and drag them into the package.  Then you will see 

the lower window like this: 

 

 
 

Notice the attachment count circled in red at the bottom, and the list view button is 

pressed to the right. 

 



 

Adding Attachment Notes 

 

Packman has a unique document structure that allows you to associate a document for 

each attachment.  Right click on an attachment and you will see this menu: 

 

 
 

 



Select “Add Attachment Note”, then the upper window will split to allow you to create 

the document associated to that attachment.  Like this: 

 

 
 

 

Saving your Package 

Save works two ways.  Check to see if Contact Manager is enabled by looking at the 

toolbar. (  = Enabled) (  = Disabled) as keys are supplied by the user or 

by Contact Manager. 

 

If you have “Contact Manager” enabled, the save process will only ask you for the 

contact to save the package for, by presenting you with a list of available contacts.  

Selecting one will supply the password and the location for the package. 

 



If you do not have Contact manager enabled, you will firsst be prompted for the name 

and location to save the package through a standard Explorer shell browse window.   

 

Next you will be prompted for the password with this dialog: 

 

 
Enter the information.  Press OK.  Your Package is saved.  Now you can close Packman.   

 

 

Opening a Package 

 

If you had permissions to create file associations on the machine you are using, then to 

reopen the package you may just double click it from any standard Explorer window.  

Windows Vista users should right click Packman and select “Run As Administrator” one 

time to get the association setup for them.  You can always select “Open” from the “File” 

menu after running Packman to open a document. 

 

If you have Contact Manager enabled, then it will determine the password if the package 

creator is from a source known by your database, and immediately show you the package 

contents. 

 

If you do not have Contact Manager enabled, you will see the package label and be 

prompted for a password like this: 

 
 

Supply the password, then the document will open.  If you forgot the password, there is 

no way to reset it or somehow open the document.  The information in the package will 

be lost forever and no tech support phone call will be able to help you.  Contact Manager 

helps you to manage that situation so that it never happens to you. 



Extracting Attachments from the Package 

 

To extract all the attachments you may select “Extract All” from the “Attachments” 

menu.  You may also view the attachments without ‘extracting’ them by double clicking 

on the one you are interested in.  You may also select one or more of the individual 

attachments and drag them into any folder on your computer. 

 

 

Setting up the Contact Manager 

 

If you use Packman frequently, it will be worth your time to setup Contact Manager.  The 

user interface doesn’t stop to ask you for passwords (that must be typed twice for 

verification) when you save files.  It doesn’t ask you for passwords that can be forgotten 

when you open files.  It doesn’t ask you where to save the file, because each contact has 

that information pre-configured.  It also doesn’t ask you for the contacts email address if 

you use the automatic email delivery feature in Packman.  You type less and work faster 

with Contact Manager. 

 

 

From the “Tools” menu select “Contact Manager” then you will see this: 

 

 
1. Check “Enable Contact Manager” 

2. Choose “Always” 

3. Press “…” to select a path and name to store the contact database 

4. Type password you want for your contact database in both password fields. 

 



Adding a new Contact 

 

Now press “Add Contact”.  You might fill out the information like this for a friend. 

 

 
Or you might fill out the information like this for a customer: 

 

 
 

Now Contact Manager will look like this: 



 
 

Now Contact Manager is all set up, and you will see this indicator in Packman: 

 
This means that Keys (passwords) are a supplied by Contact Manager  

To disable Contact Manager, press the  button and it will change to  

meaning that passwords are going to be supplied by the system user.  You should not 

leave contact manager enabled on your machine if you are not there and the machine is 

not locked or anyone with walkup access to your computer could open your private 

information. 

 

Delivering by email 

 

If you use Outlook or a standard email client (not web mail), then you may want to use 

that to deliver your packages.  Press the icon of the flying envelope and it will be 

delivered.  If contact Manager is enabled you will be prompted for the contact to deliver 

to otherwise it will prepare the email for you and you must type the address you want it 

delivered to then send it yourself. 

 

 

Email reply threads 

Pressing the “Re:” button is designed to help you manage a typical conversation through 

a Packman file that is exchanged back and forth between two people.  Each users 

response becomes an attachment so that the current message is the only document in the 



primary document.  The previous conversation is archived in the attachments and clearly 

labeled by the author name. 

 

 

Splitting files 

 

Packman also has support for file splitting, so that large packages can be sent through 

email that often has limitations on the attachment size per email.  It can also create 

Packages that span CD’s, DVD’s, or USB storage devices.  Select “Split File into 

segments” from the “Tools” menu: 

 

This example would split a huge file into 650 MB chunks that can be burnt to CD. 

 
 

If you enter 4200, then it will dice up the huge file into 4.2 GB chunks for DVD. 

 

If you enter 10, then it will split a file that is too big to email through Gmail, Hotmail, or 

Yahoo mail into 10MB chunks for allowable delivery, some other email systems have 

limits as low as 1 to 5 MB. 

 

Blu-Ray 8 layer confines you to 200GB per disk, so if you wanted to cipher a backup of 

of your Terabyte database or movie collection Packman gets the job done. 

 

To reassemble the file, put all the pieces in the same directory.  Only one file is a 

PackMan Package.  Open it normally and it is automatically reassembled for you. 

 

 

Creating a script 

Packman has built in support for automated scripting of attachments.  If you have a large 

complex directory structure and need to exclude or include certain files or folders 

PackMan allows you to define the rule once then it can automatically Package only what 

you need saving you the time of manually picking out the required attachments.  This is 

especially handy for backups.  You can select to include only a certain file type like 

images, exclude only a certain type, or choose from several ways that a file name or 

folder can match the criteria for inclusion or exclusion.  Just drag and drop from explorer 

into the list for exact matches of file names or folder names. 

From the “Tools” menu select “Scripts…” 



 
 

 

Attachment Snapshots 

 

By default ‘Attachment Snapshots’ are disabled, and most users will want to leave it that 

way.  If you are adding attachments of data that tends to change very frequently most 

often you want the most recent version and by default that is what will happen.  When the 

attachment is ‘added’ to the package, Packman only adds a pointer to the file.  The data is 

not copied into the package until the user saves the document.  This allows for 

cancellations and changes of large files to happen instantly during package creation and it 

consolidates wait time during compression and encryption to a single time making the 

application operate more smoothly and responsively during package creation.  You can 

however instruct Packman to take a snapshot (a copy of the source file) at the moment 

that it is added – ensuring that the data you added is exactly what gets put into the 

package even if you press ‘Save’ an hour after adding the attachment.  Since Packman is 

designed for many purposes it supports cases of rare need and this is one. 



Windows Shell Extensions 

 

Packman installs to the Windows system menus, so that you can create a Package from 

any folder without having to start Packman and go through the manual process of 

creating a package.  Just right click on any folder on your computer, Select Packman, 

then “Add selected to new package”.  Packman will start with the package created.  

Saving it will behave like normal, prompting you for the Contact and in doing so 

obtaining the password and path to store the file. 

 
 

Alternatively, you may want to specify the path from a windows system menu.  Just right 

click in the folder that you want the packman file to be in Select “New” then “Package” 

to create a new empty package in that location: 

 
 

 

Refreshing Attachments 

 

Packman has the ability to ‘refresh’ itself from the files that were used to create the 

package.  Each attachment in Packman contains information about where the attachment 

came from, and Packman can update and re-package the file with one click.  Other 

utilities do not store the source of the data that they contain so they cannot refresh it, 

compare against it, or notify you when the information has changed.  By storing more 

information about the attachments, Packman is able to provide more features for 

managing them. 



 

Advanced Attachment Management User Interface 

 

There are several different ways that Packman can obtain attachments from the user.  A 

file may be dropped into Packman, or selected from a source folder through the menu 

(because Packman works even without a mouse).  A folder containing more folders and 

files within them can also be dropped into Packman.  Ideal viewing of the attachments 

may depend on the number of attachments and their organization on disk.  Packman 

allows you to view them in a hierarchy or in a list.  This is a hierarchy view, it’s easier to 

see what file are in what folders, and you can view only a subset of the attachments if you 

prefer by opening only the folder(s) desired: 

 

 
 

The following image is a different view of the same attachments, in the list view: 

 



 
 

The list view is preferable for quickly viewing and sorting the attachments in a certain 

order.  By clicking on the column header, the attachments are sorted in that order.  Click 

on the word “Attachment” in the list header and they will be sorted alphabetically, click it 

a second time and they are sorted reverse-alphabetically, likewise with the size or date or 

any of the other information.  If you are managing many files in a single attachment and 

searching for a certain one you may find what you are looking for faster in the list view. 

In the Tree view, you can see quickly that the attachment “B2Btechnology.txt” is in two 

different places.  Remember Packman also supports versioning which allows you to store 

two files with the same name in the same folder – this is a unique feature not allowed by 

your operating system or other file management tools.  When using other advanced 

features the multiple views is a handy way to quickly find what you are looking for. 

 

 

 

 



User Friendly GUI 

 

The GUI has many features that make it run smoothly and intuitively.  It keeps you 

informed of progress with progress bars, and status messages so you know what’s 

happening when very large files or large numbers of files are being processed.  It has 

clear informational messages to keep you from accidentally getting unintended results. 

 

 
 

Notice in this “File Exists” dialog, the user has the option to select the next available file 

name, in the case of this example: DriverMySQL(2).cpp 

 

The User Interface is also multi-tasking where possible.  For example when opening a 

package with many attachments it will allow you to start editing the document while the 

packages are still loading.  The GUI always defaults paths to last know locations to save 

you from re-navigating a file or directory dialog to the same place for repetitive tasks.  

You are never asked to type anything that can be selected. Care has been taken to keep 

the user interface friendly. 



 

Waitbar and Progressbar inside Statusbar 

 

Depending on the size of package and number of attachments various operations may 

take noticeable time to complete.  The User Interface is very advanced about allowing 

you to multitask while the last action is still being completed.  For many tasks the finish 

point is known so a progressbar in blue will give you a visual of the percentage of work 

completed for the active task such as saving or opening a large package. This will appear 

across the bottom of the application if the status bar is visible.  In some cases the work 

finish point is not known, for example dropping a folder that contains many files from 

windows explorer into Packman, or running a script.  Because counting all the files first 

will needlessly double the time to complete the action, Packman displays a “Waitbar” in 

place of the progress bar.  The waitbar shows current activity and a visual of a moving 

stack of hourglasses while the action is being performed. 

 

 
 

In both cases the current task may be aborted by pressing , and in both cases the 

item currently being processed is displayed to the left of the Progress/Wait bar.  When 

processing large items, the percentage complete of the item is displayed in text next to the 

current item, so for example if packing several large attachments you see both the 

percentage complete of the entire task as well as the percentage complete of the current 

item. 

 

 

Package Completeness Validation 

 

Every time a package is opened, Packman verifies that the package file is complete and 

warns you if it is not.  Incomplete packages may often still be opened and perhaps some 

of the data is still accessible.  Packman notifies you of corruption or incompleteness, but 

does not condemn the entire package incase portions contain good data. 



 

 

Transactional Integrity 

 

Transactional Integrity is new to version 3.0 of PackMan.  It ensures that an action is “All 

or nothing” and it allows you to “Roll back” groups of operations.  For example, if you 

intended to drop c:\MyFolder into a package that had many existing attachments, but 

accidentally dropped c:\, there is a “Cancel” button that will not only stop adding the 

attachments from the most recent action, but it will rollback any that have been added.   

 

PackMan stores a history of transactions so that it is possible to browse them and “undo” 

actions or groups of actions by selecting “History/Rollback” from the “Attachments” 

menu.  Attachments may be added from various user interface sources: Drag and drop, 

menu selection, and by running scripts.  The following image shows the dialog that 

supports “Undo” or “Rollback” 

 

 
 

 

Transactional Integrity is included so that Packman will meet the strictest guidelines for 

various data warehousing groups that require such mechanisms while managing their 

data. 

 

 

 

 



 

User interface preferences 

 

Packman has the unique ability to run as either MDI (Multiple Document Interface) or 

SDI (Single Document Interface)  The default is SDI, meaning that Packman can only 

open a single package at a time.  To open two packages with SDI requires running two 

instances of Packman.  Under the “View” menu the default is set to “One Package per 

Packman”. 

 

You can uncheck “One Package per Packman” then it looks like this when you have 

multiple packages open at once: 

 

 

 

 
 



PackMan Application Programming Interface (API) 

PackMan supports a simple programming interface so that languages such as C#, Visual 

Basic, Perl, Java, .NET, C++ and others can create a .PKM file in just a few lines of code.  

This allows custom accounting systems, custom business systems, and software product 

vendors to integrate Packman technology into their own. The API is very easy to use for 

both reading and writing .PKM files.  Attachments can be added, extracted, or queried in 

a single line of source code.  The following section is a .NET C# example that shows the 

simplicity of how to manipulate PackMan files with the toolset from UBT. 

 

The Packman file system has many advanced features designed for systems integrations.  

Each attachment has process instructions that serve the same purpose as XML Process 

Instructions, however more flexible because there is no format specification enforced by 

Packman.  Each attachment has a 256 bit SHA-2 hash associated to identify changed 

attachments without relying of file time stamps, and guarantee proper transmission.  

Package creation options may be designed to work more efficiently with attachments that 

commonly grow in size and are often re-packed.  The Packman file system has been 

refined for 5 years now and contains reserved storage specifiers at various layers that are 

designed for forward compatibility and for custom implementations that can use the 

standard viewer. 

 

 

Sample C# Syntax to create PackMan files: 

 
// Create a new PackMan COM object 

PACKMANCOMLib.PackManClass PKM = new PACKMANCOMLib.PackManClass(); 

 

// Either open an existing .PKM file –-or-- create a new one 

int nRslt = PKM.Open(“d:\\Package.pkm”, “Password”); 

-- or -- 
int nRslt = PKM.New(“d:\\Package.pkm”, “Label”, “Password”, “Author”); 

 

// Get the Primary document 

string strDest; 

int nRslt = PKM.GetPrimaryRTFDocument(out strDest); 

 

//AddAttachmentFromFile(File, RTF Note, Process Instructions, Grow Room) 

int nRslt = PKM.AddAttachmentFromFile(“d:\FileToAttach.doc”, "", “”, 0); 

 

// Close the .PKM file 

PKM.Close(); 

 

UBT has a complete working example in Visual Basic, C++, and C# that shows how to 

do all of the most common tasks with .PKM files.  Java, Perl, Python and other languages 

are already supported through either of the development interfaces that include COM 

object, ActiveX(OCX), and DLL interfaces.  This is the only Packman related technology 

that UBT will generate revenue from, so if you don’t understand what this is, you don’t 

need it and PackMan will always be free for you. 

 

 



The Future for Packman 

 

Software design can be focused on various goals.  Very often “time to market” takes 

precedence over the internal organizational layout.  Those kinds of applications are 

difficult to enhance because they made no provisions for the future and therefore they 

were easier to develop and took less time.  Many times they require re-writes of large 

sections and easily fall behind cutting edge technology.  The internal layout of PackMan 

has made provisions for the future everywhere.   The internal source code is well 

organized, well documented, and designed to be extended by engineers who had no part 

in the development of the initial product. 

 

You can expect Packman to get better with time, support the latest needs quickly, and 

become very rich in features because it has been designed as a foundation for the future.  

There are literally no limits with RTF document formatting, Tables, Embedded Objects, 

Page Formatting, and Document Layout can all be managed with professional quality.  In 

time Packman will integrate more word processing features.  It has made provisions for 

obtaining documents from various sources including Scanners, Database merges, and 

existing applications.  It also will support saving packages to various locations, including 

remote website publishing (partially already supported), burning to CD/DVD, and 

delivery through complex networking environments by integrating another UBT 

technology called Xfer that is already built into the foundation of Packman. 

 

UBT is dedicated to maintaining a very robust free version that is not filled with 

limitations designed to force users to purchase a costly version.  By maintaining this 

position, UBT will build more value in the product by building a large user base and 

therefore building value in the development tools UBT will sell to other software 

vendors, and corporate IT managers for tightly integrating support for Packman into their 

information systems.  UBT will also provide software consulting services that will 

provide specialized needs surrounding the Packman Technology, as there are countless 

applications for this technology. 

 

 

^ 

Package Manager  

 

United Business Technologies 

 

Copyright 2004-2015 – All rights reserved 

_______________________________________ 


